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What is Remote Network Accelerator (RNA)?
What is Remote Network Accelerator 
(RNA)?
LapLink RNA speeds up access to your office network from remote locations without changing the 
way you work. Running in the background on your computer, LapLink RNA client software commu-
nicates with the LapLink RNA Server on the office network to improve performance by reducing 
the amount of data transferred over the connection. Whether your connection is wired or wireless 
(802.11 and GPRS), or uses a VPN or RAS server, your remote network connections can benefit 
from LapLink RNA.

Speeds up remote access
Like an increasing number of business people, you can no longer do 
without the network when you leave your office. Whether from home, 
a hotel, or some other remote location, you connect to your office 
network via a VPN Internet connection as a matter of routine. 
Unfortunately these VPN connections typically are so slow that they 
reduce productivity and often incur unnecessary costs.

LapLink RNA speeds up VPN access to the network by 300-400 
percent. It does so by caching and compressing data and transferring 
it more efficiently, thereby reducing network traffic and making you 
more productive.

LapLink RNA works regardless of how you connect to your office 
network. Connections are improved whether you connect over the 
Internet through a virtual private network (VPN) connection or a 
remote access server.

Works in the background
When you connect to the office network you work much as you do 
when connected directly to the network in the office. Adding LapLink 
RNA accelerates your work, but nothing else changes: you don’t have 
to learn new routines or change the way you work. Except for the 
improved performance, you aren’t even aware that LapLink RNA is 
running.

A client/server software solution
LapLink RNA consists of two services:
• LapLink RNA (the client service)
• LapLink RNA Server

The client runs on the computer you use to connect to the office. The 
server runs on a computer on your office network. The client and the 
server work together to accelerate connections.

LapLink RNA is entirely a software solution; there’s no need to buy 
new equipment. And it works with a variety of remote access servers, 
(Windows NT/2000/XP RAS, for example) and hardware.
3



Getting help
Getting help
The LapLink RNA documentation set consists of electronic manuals and online Help. The elec-
tronic manuals help you understand how LapLink RNA works. See LapLink RNA Help for quick 
reference, step-by-step procedures, and a glossary of terms.

Where to look for information
For your 
convenience, the 
LapLink RNA 
manuals are 
provided in Adobe 
Acrobat format on 
the RNA CD-ROM.

This documentation set is comprised of these components
• This Remote Network Accelerator Installation and Quick Start 

Guide provides installation instructions and information.
• The Remote Network Accelerator User’s Guide and the Remote 

Network Accelerator Administrator’s Guide provide specific 
information about the server and client service.

• LapLink RNA Help is online documentation providing instructions, 
complete troubleshooting, and reference. It contains detailed 
information about options in the software, and a glossary of 
LapLink RNA terms.

Accessing Help
For definitions of 
terms used in any 
LapLink RNA 
document, look in 
the glossary in 
LapLink RNA Help.

The help system provides easy access to answers about the 
software. LapLink RNA Setup installs Help for the RNA Service 
Manager. There are many ways to access RNA Help. Choose the 
method that best suits the situation.

To access LapLink RNA Help:
• From any dialog box in LapLink RNA, click the Help button.
• From the LapLink RNA Service Manager, click the Help button on 

the toolbar, click LapLink RNA Help Topics on the Help menu, or 
press F1.

• From the Windows Start menu, point to the LapLink RNA program 
group and then click Help for LapLink RNA.

Using Help
LapLink RNA Help is a Windows Help file with a Help Topics window 
that lets you navigate through the help system and find the 
information you need. To return to the Help Topics window from any 
help window, click the Help Topics button. 

To use What’s This? Help:

1 In any LapLink RNA dialog box, do one of the following:
• Right-click the option you want help on and click What’s This? on 

the shortcut menu.
• In the top right corner of the dialog box, click the question mark 

button and then click the option you want help on.
• Click or tab to an option and press F1.

2 Click anywhere or press any key to close the pop-up window.
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Installing LapLink RNA Server and Client
Installing LapLink RNA Server and 
Client
Install LapLink RNA server on a network server or a computer connected to the network. Insert the 
LapLink RNA CD-ROM in your CD-ROM drive and click Install LapLink RNA Server.

Before you install LapLink RNA Server, be sure that your computer 
meets the installation requirements. Check the Installation 
Requirements section of the Administrator’s guide for details. 

Install the LapLink RNA Server on your network server or on a 
computer connected to the network. This computer does not have to 
be dedicated, but you must have administrator’s rights to it and it 
should be available at all times.

In order to install 
LapLink RNA Server, 
you must have 
Windows 
administrator rights 
to the computer.

To install LapLink RNA Server:

1 Insert the LapLink RNA CD-ROM in a CD-ROM drive.

2 On the LapLink RNA welcome screen, click Server.

3 Follow the instructions on your screen.

4 Restart Windows to enable the LapLink RNA Server.

To install LapLink RNA client:

1 Insert the LapLink RNA CD-ROM in a CD-ROM drive.

2 On the LapLink RNA welcome screen, click Client.

3 Follow the instructions on your screen.

4 Restart Windows to enable the LapLink RNA client.
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Distributing Remote Network Accelerator to end users
Distributing Remote Network 
Accelerator to end users
Use Make Client Diskettes on the Remote Network Accelerator setup screen to make copies of the 
Client software available to users. For wider distribution, copy the client installation folder to an 
available network drive.

Creating diskettes for client installation
To create diskettes for installing the client:

1 Insert the LapLink RNA CD into your CD-ROM drive and click 
Client.

2 Click Make Client Diskettes.

3 Follow the steps on the screen.

!TIP You will need 3 blank formatted diskettes before beginning.

Setting up the client installation on a 
network
Putting the client installation on a network is a convenient way to 
make the service available to many users at once.

To set up the client installation on a network:

1 Explore the LapLink RNA CD-ROM with Windows Explorer.

2 Copy the contents of the LeClient folder to an available network 
folder.

3 When a client has connected to the network, have them run 
Setup.exe from the network folder.
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Customizing client installations (for administrators)
Customizing client installations (for 
administrators)
You can customize client installations by hiding them from users, specifying particular LapLink 
RNA servers, naming the folder in which to install LapLink RNA, and so on. To change a client 
installation, create a setup file named Script.txt and include the edited file in the LapLink RNA 
Setup folder (LECLIENT) folder is located. 

Before distributing LapLink RNA you can create a Setup script file to 
modify the installation. This file specifies how Setup proceeds on 
client computers, and what settings take effect. 

For example, you can completely hide Setup or show certain dialog 
boxes while hiding others. Or you can display dialog boxes but not 
allow users to change the settings you have specified. 

This kind of Setup (sometimes called “scripted” or “silent”) is 
particularly useful for controlling options that some users might have 
trouble designating, such as LapLink RNA servers.

NOTE We 
recommend a short 
path to the install 
folder. For example, 
C:\LLRNA.

1 In Notepad or another text editor, open the sample script file that 
best suits your needs.
For information about the different sample scripts provided with 
LapLink RNA, see the document “Sample Installation Scripts.doc” 
in the Sample Installation Scripts folder on the LapLink RNA CD-
ROM.

2 Alter the settings as necessary.
For details about the settings in the script, see the section 
Modifying the RNA Setup script. 

3 Save the file as Script.txt in the LapLink RNA Setup folder you 
created on the network.
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Modifying the LapLink RNA Setup script
Modifying the LapLink RNA Setup 
script
Modifying the Setup script, Script.txt, changes how an installation proceeds and options are set. 
This section lists the various settings in the file and how they affect installation.

Controlling the execution of Setup
Create and modify 
Script.txt in Notepad 
or another text 
editor.

You can change settings in Script.txt to alter the way in which Setup 
proceeds.

There can be only 
one [Setup] section 
in the Script.txt file.

Specifying LapLink RNA servers
Users can create lists of RNA servers to which they can connect. 
From this list of preferred servers they choose the server they want to 
accelerate their network access.

Hiding all or part of the installation

[Setup]
User Interface=VISIBLE

Change the setting to HIDDEN to 
completely hide Setup from the user. 
The progress of Setup is recorded in 
a log file.

[Dialog Name Dialog]
Visible=TRUE

ReadOnly=FALSE

Change the setting to FALSE to keep 
a particular dialog box from being 
displayed during Setup. Note that 
Dialog Name is the name of one of 
the Setup dialog boxes as listed in 
Script.txt.

Change the setting to TRUE to pre-
vent a user from changing any set-
tings in the dialog box.

Setting the type of installation

[Setup]
Setup Type=TYPICAL

Change the setting to CUSTOM to 
require a custom Setup.

Restarting the computer after Setup

[Setup]
Reboot=FALSE

Change FALSE to TRUE to restart 
the computer at the end of Setup. 
This setting applies only if the Finish 
Setup dialog is hidden by the script.

Setting the setup log file option

[Log File]
Log=FULL

Change FULL to ERRORS to record 
only error messages or to NONE to 
record nothing. Leave at FULL for a 
complete report.
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Modifying the LapLink RNA Setup script
Using the Setup script, you can create a list of preferred servers and 
designate the one to connect to. This saves users the trouble of 
finding a server on the network and discourages them from making 
inappropriate connections.

To specify LapLink RNA servers create a new section and give it this 
header: [Preferred Server List]

Specify a server first by its name and then by either the type of 
connection or the server’s IP address. You can designate just one 
preferred server or as many preferred servers as necessary.

From the list of preferred servers, you can specify the one server to 
be used for network acceleration. Include this option in the [Preferred 
Server List] section.

Designating a preferred server

[Preferred Server List]
ServerNameN=NAME

For N type 1 for the first server, 2 for 
the second, and so on. The number 
differentiates between the servers. For 
NAME type the name of the server. For 
example, type this to add the first 
server, named ACME LapLink RNA 
Server, to the list: 
ServerName1=ACME LapLink RNA 
Server

ConnectionTypeN=TYPE

or

ServerAdressN=ADDRESS

For N repeat the number used with 
Server- Name. For TYPE specify the 
connection type: TCP/IP, IPX, or SAP.

For N repeat the number used with 
Server- Name. For ADDRESS type the 
server’s TCP/IP address. For example, 
this specifies the ACME LapLink RNA 
Server computer’s IP address: 
255.255.255.255

DomainNameN=DOMAIN (Optional) For N repeat the number 
used with ServerName. For DOMAIN 
type the name of the domain in which 
the server is located.
Use this option when you have to dis-
tinguish the designated server from 
another server with the same name. 

Designating the LapLink RNA server
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Modifying the LapLink RNA Setup script
Specifying other Setup options

A sample Script.txt file
The following text is from the sample installation script “Partially 
Interactive Install.txt” available on the RNA CDROM.

[Setup]

User Interface=VISIBLE

Setup Type=TYPICAL

Destination=C:\LLRNA

ServerName1=NAME For NAME type the name of the 
server as designated in Server-
Name. For example, type this to 
designate ACME LapLink VPN 
Server:
ServerName1=ACME LapLink VPN 
Server 

Creating an uninstall script

[Setup]
Uninstall=TRUE

Normally, Script.txt installs LapLink 
RNA. However, you can make it an 
uninstall script by adding this line to 
the Setup options. Settings that are 
meaningless in an uninstall script 
(such as which servers are desig-
nated) are ignored when the script is 
run.

Designating the installation folder

[Setup]
Destination=NAME

For NAME, specify the drive and 
folder in which LapLink RNA is to be 
installed. For example, this line installs 
LapLink RNA in a subdirectory of the 
ACME directory:
Destination=C:\LLRNA 

Setting registration information

[Setup]
User=NAME
Organization=NAME
Serial Number=
NUMBER

Use these three options to preset the 
name of the user, the organization, 
and the product serial number. For 
example, these lines specify registra-
tion information for users at ACME, 
Inc.:
User=Acme Employee
Organization=Acme, Inc.
Serial Number=1234567
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Modifying the LapLink RNA Setup script
Program Group=ACME LapLink RNA

User=Acme Employee

Organization=Acme, Inc.

Serial Number=1234567

[Services]

Network Accelerator=TRUE

[Log File]

Log=FULL

[Preferred Server List]

ServerName1=ACME Remote Network Accelerator Server

ServerAddress1=255.255.255.255

Network Accelerator=ACME Remote Network Accelerator Server

[Welcome Dialog]

Visible=TRUE

ReadOnly=FALSE

[License Agreement Dialog]

Visible=TRUE

ReadOnly=FALSE

[Registration Info Dialog]

Visible=FALSE

[Setup Type Dialog]

Visible=FALSE

[Service Selection Dialog]

Visible=FALSE

[Program Group Dialog]

Visible=FALSE

[Finish Setup Dialog]

Visible=TRUE

ReadOnly=FALSE

[Start Configuration Dialog]

Visible=TRUE

ReadOnly=FALSE

[Finish Configuration Dialog]

Visible=TRUE

ReadOnly=FALSE
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Installing LapLink RNA client (for end users)
Installing LapLink RNA client (for end 
users)
Before you can use LapLink RNA, you must install the client software on your computer. To install 
from a network, run the Setup.exe file from the network folder designated by the system adminis-
trator. To install from the CD-ROM, click Install Client on the LapLink RNA welcome screen.

In the RNA Setup program you can choose between a typical or a 
custom installation. You can also specify the folder for installation.

You may receive LapLink RNA preconfigured, with network and 
installation information set for you. When system administrators 
distribute LapLink RNA Setup via a network, they can customize the 
installation in various ways. For example, they can specify a server 
for you or hide all or part of the installation. If you have questions, 
contact your system administrator.

Your system 
administrator installs 
and sets up the RNA 
Server.

When Setup is complete, you must restart Windows before using 
LapLink RNA.

To install LapLink RNA client from diskettes:

1 Double-click Setup.exe on Disk 1.

2 Follow the instructions on your screen.

To install LapLink RNA client from a network:

1 Navigate to the network folder containing the LapLink RNA 
installation files.
Contact your system administrator for the location of the 
installation files.

2 Double-click Setup.exe.

3 Follow the instructions on your screen.

To install LapLink RNA client from a CD-ROM:

1 Insert a LapLink RNA CD-ROM in a CD-ROM drive.

2 On the LapLink RNA welcome screen, click Install Client.

3 Follow the instructions on your screen.
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Understanding the LapLink RNA Service Manager
Understanding the LapLink RNA 
Service Manager
Manage Remote Network Accelerator from the LapLink RNA Service Manager. Open the Service 
Manager by double-clicking its icon on the Windows taskbar. Enable and disable the service, dou-
ble-click the service to view or change its properties, or designate LapLink RNA servers.

You can manage the RNA service using the LapLink RNA Service 
Manager. The Service Manager displays the service, including its 
status and description.

Enabling and disabling services
The Service Manager lists the installed service (appears as LapLink 
RNA Server if appropriate), and whether acceleration is enabled or 
disabled. You can change acceleration status for the service by 
clicking the Enable or Disable button.

To enable or disable a service:

1 Open the Service Manager by double-clicking its icon on the 
Windows taskbar.

2 Click the name of the service on the toolbar.

3 Click the Enable or Disable button.

Viewing properties
View and change LapLink RNA service properties in the RNA 
Properties dialog box. 

To open the LapLink RNA Properties dialog box:

1 Open the Service Manager by double-clicking its icon on the 
Windows taskbar.

2 Do one of the following:
• Double-click the name of the service.
• Click the name of the service and click the Properties button.
• Click the name of the service and click Properties on the Service 

menu.
• Right-click the name of the service and click Properties on the 

shortcut menu.

Designating and connecting to a Remote 
Network Accelerator server
Remote Network Accelerator clients can open the Designate Servers 
dialog box from the Service Manager. For more information on 
designating servers and connecting, see the Remote Network 
Accelerator User’s Guide.
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Understanding the LapLink RNA Service Manager
To designate a LapLink RNA Server:

1 Open the Service Manager by double-clicking its icon on the 
Windows taskbar.

2 On the Service menu, click Designate Servers.

3 Select the server you want to use, or type in the IP address.

4 Click OK

!TIP Contact your network administrator to get the IP name or 
address of the LapLink RNA server. If you need to determine the IP 
address yourself, information is available in LapLink’s online 
knowledge base. Use this URL: (Link: http://www.laplink.com/support/
kb/article.asp?id=204)http://www.laplink.com/support/kb/
article.asp?id=204

To connect after designating a LapLink RNA Server:

1 Click the Connect button.

2 Confirm the name or IP address of the LapLink RNA Server you 
want to connect to.

3 Click Connect, and then Close when the connection is made.
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Keeping an activity log
Keeping an activity log
LapLink RNA uses a log to track its activity. Change logging settings in the Logging tab of the RNA 
service. Check or clear the Enable Logging box to turn logging on or off. In the Log Activity box, 
check the types of information you want to log.

LapLink RNA can log activity to keep a record of the events that occur 
while it’s running. Logs are chronological lists of occurrences, such as 
connections, transfers, and disconnections. 

In Windows 98, logs are stored in a text file and viewed in Microsoft 
WordPad. In Windows NT, Windows 2000, and Windows XP, events 
are recorded in the Event Log that Windows maintains.

Understanding logged events
Each event in the LapLink RNA log shows this information:
• Time the event occurred
• Type of event (information, warning, or error)
• Event ID number
• Description of what occurred

These details help you understand what happened during your RNA 
work session.

Specifying what to log
You can control which types of information LapLink RNA stores in the 
log. For example, you can specify that you want to see only 
connection and disconnection information.

To specify what to log:

1 Open the LapLink RNA Service Manager by double-clicking its 
icon on the Windows taskbar.

2 Double-click the service name and then click the Logging tab.

3 Do one or more of the following:
• Turn logging on or off by clicking the Enable Logging box.
• Under Log Activity, specify the types of information to log.

4 Click OK.
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Logging activity in Windows 98
Logging activity in Windows 98
In Windows 98, LapLink RNA stores the logs in text files. Change the log file location by typing or 
selecting a new path. Specify how many days to store daily logs in the Number of Daily Logs to 
Save box. To remove all messages from today’s log, click the Empty Today’s Log button. To view 
the log in WordPad, click the View Today’s Log button.

When RNA services run on Windows 98, they store the logs in text 
files. There is a different log file for each day. Each event in each log 
appears on one line of text.

Setting logging options in Windows 98
Set Windows 98 logging options to specify where to store the logs 
and how many daily logs to store. Determine where to store the log by 
specifying a folder on your local hard disk. LapLink RNA cannot store 
logs on a network, floppy, or CD-ROM drive.

To clear all events 
from the current 
day’s log file, click 
the Empty Today’s 
Log button.

Choose how many daily logs to save to control how long an old log 
file remains on your computer. You can save between 1 and 99 logs. 
When choosing this number, consider how likely it is that you will 
need to check previous days’ log files, and how much disk space you 
can spare on your computer.

To set logging options in Windows 98:

1 From the Logging tab, do one or more of the following:
• Type a path in the Location box, or click the Browse button to 

search for a folder where you want to store daily logs.
• In the Number of Daily Logs to Save box, type a number or click 

the arrows to set how many daily logs to save.

2 Click OK.

Viewing the log in Windows 98
In Windows 98, LapLink RNA displays the log in Microsoft WordPad. 
LapLink RNA runs WordPad and opens today’s log file for you; there 
is no need to search for the file.

To view today’s log in Windows 98
• From the Logging tab, click the View Today’s Log button.

If you do not have 
Microsoft WordPad, 
you can install it from 
your Windows 98 
disk(s).

Logs from previous days are stored in the folder specified on the 
Logging tab in the Location box. Use Windows Explorer to locate the 
appropriate log file and open it in WordPad. LapLink RNA log files are 
named with the prefix FAC, followed by the date. For example, the log 
file named FAC0407.log is the RNA log for April 7.
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Logging activity in Windows NT, Windows 2000 or Windows XP
Logging activity in Windows NT, 
Windows 2000 or Windows XP
In Windows NT, Windows 2000 or Windows XP, LapLink RNA records activity in the Event Log. To 
view the log in Event Viewer, click the View Event Log button. To show only LapLink RNA events, 
click Filter Events on the View menu in Event Viewer, and then click the LapLink RNA service in 
the Source box.

Viewing the log in Windows NT, Windows 
2000 or Windows XP
When LapLink RNA services run on Windows NT-based computers, 
they log activity in the Event Log created and maintained by 
Windows. Each event appears on one line of the Windows Event 
Viewer.

To view the log in Windows NT, Windows 2000 or Windows XP:
• From the Logging tab, click the View Event Log button.

Showing LapLink RNA events only
The Windows NT Event Viewer includes events logged by other 
programs running on your computer. When LapLink RNA service 
opens the Event Viewer, it automatically filters the display to show 
events for that service only. This lets you easily read the LapLink RNA 
information you need. Any time you run Event Viewer from the 
Windows Start menu rather than from the Logging tab in LapLink 
RNA, you can change the display filter yourself.

To show LapLink RNA events only in Windows NT:

1 On the Windows Start menu, point to Programs and 
Administrative Tools and then click Event Viewer.

2 On the View menu click Filter Events.

3 In the Source box click the LapLink RNA service.

4 Click OK.

To show LapLink RNA events only in Windows 2000 or Windows 
XP:

1 Right-click My Computer and point to Manage.

2 Click to expand Systems Tools, then Event Manager, and 
highlight Application.

3 On the View menu click Filter.

4 In the Event source box click the RNA service.

5 Click OK.
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Troubleshooting
Troubleshooting
This section provides suggestions for solving problems and improving performance. These sug-
gestions are designed as a quick overview of possible solutions, with enough information to guide 
experienced users to solutions.

Problems with the LapLink RNA Service 
Manager
Everything in the Service Manager is grayed.
The Service Manager appears grayed when you suspend all 
services. To return to normal running state, click Suspend All Services 
on the Service menu so that it is unchecked.

Text in the Service Manager table is cut off.
You can resize the columns in the Service Manager. Drag the dividers 
that separate the column headings to resize them manually. You can 
also double-click a divider to automatically resize the column to fit the 
text.

When I click the LapLink on the Web item on 
the Help menu, I get an error.
You need a Web browser and an Internet connection to access 
LapLink’s Web site.

If you have a Web browser and an Internet connection and the site 
still does not open, you can open it manually by typing the site 
address in your browser: http://www.laplink.com

Problems with logging
I can’t find the log.
In Windows NT, Windows 2000 and Windows XP, events are logged 
to the Windows Event Viewer. To view these events, click the View 
Event Log button on the Logging tab of the LapLink RNA service.

In Windows 98, LapLink RNA stores the log in a text file. The default 
location is within the LapLink RNA program directory. It might have 
been moved: check the location on the Logging tab of the LapLink 
RNA service.

The log is empty.
Make sure logging is enabled. Check the Logging tab of the RNA 
service. The Enable Logging box and at least one Log Activity box 
should be checked.
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Problems with logging
If there hasn’t been any log activity (LapLink RNA has not been 
started or stopped, or no network files have been opened), there 
won’t be any information in the log.

The information I need isn’t in the log.
You specify what is logged on the Logging tab of the RNA service.

In the Log Activity box, click the activities you want logged so that 
they are checked.

When I open Windows Event Viewer from the 
Service Manager to find information logged 
from other programs, I see only LapLink RNA 
events.
This is as designed. You can change the filtering in Event Viewer to 
show all events: click Filter Events on the View menu.

If you open Windows Event Viewer from outside of LapLink RNA, it 
should run with normal settings.

I don’t have WordPad. How can I view the 
Remote Network Accelerator log in Windows 
98?
You must have WordPad to view the log in Windows 98. WordPad 
comes with Windows 98.

To install WordPad:

1 Double-click Add/Remove Programs in the Windows Control 
Panel.

2 On the Windows Setup tab, click Accessories and click Details.

3 In the Components list, click WordPad so that it is checked.

4 Click OK, and then click OK again to install WordPad.

How can I see the log for a previous day?
In Windows NT, Windows 2000 and Windows XP, the Event Viewer 
settings Maximum Log Size and Event log Wrapping determine how 
long events remain in the log. If a LapLink RNA event is recent 
enough that it is still in the Windows log, then you can view it in Event 
Viewer by scrolling to the day it occurred. For information about Event 
Viewer settings, see Windows Help.

In Windows 98, the Number of Daily Logs to Save setting in the 
service properties determines how long RNA logs are stored. For 
example, if the Number of Daily Logs to Save setting is 5, then you 
can find five previous days’ logs on the computer’s hard disk. 

The logs are stored in the folder specified in the Location setting in 
the service properties, and are named by date. For example, the log 
for LapLink RNA for August 3 is named FAC0803.log, the log for 
19



Problems with logging
August 4 is named FAC0804.log, and so on. To view a previous day’s 
log in Windows 98, open the appropriate .log file in WordPad.
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